






































































































































































































































































































































































































































































































































































































Chapter 10 

Extended Gerber 

GerbTool supports the extended Gerber data format, (sometimes referred to as 
274X), developed by Gerber Systems, Inc. (GSJ). This format provides for the 
inclusion of aperture-data directly in the Gerber data files (embedded apertures), 
flexible aperture definitions and easy single file compositing. 

Embedded apertures 

R:J Note While it not necessary to understand the syntax of extended Gerber to 
manipulate Extended Gerber files within GerbTool, several examples of this syntax 
are provided below. These examples are provided to acquaint you Extended Gerber 
only. See the instruction manuals provided with your photoplotter, or contact GSI 
directly, for more information on the extended Gerber syntax. 

An extended Gerber file contains all aperture definitions necessary to plot the data, 
thereby eliminating the need for an external aperture list. An aperture is defined 
within an extended Gerber file with an AD command as follows: 

%ADD<code><macro_name>,<parameter_list>*% 

For example: 

%ADD10C,O.06XO.020% 

This example defmes D I 0 as a simple 60-mils round flash using the GSI intrinsic 
aperture macro "C." 

GerbTool allows you to edit aperture definitions using the Edit AD button within the 
Edit dialog box. See Chapter 7: Command reference for more information. 
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Aperture macros 

Aperture macros describe the size and shape of special apertures. Using aperture 
macro primitives, you can design complex aperture shapes. Each primitive describes 
a basic shape such as a circle or a line. Each primitive also specifies its polarity 
(on/off) allowing data to be removed for such features as donuts or spokes in a 
thermal. Shown below are the different primitives available. 

Number Type Parameters 

Circle on/off diameter xcenter ycenter 

20 Line-Vector on/off width xbeg ybeg xend xend rot 

21 Line-Center on/off width height xcenter ycenter rot 

22 Line-Lower left on/off width height xloc yloc rot 

4 Outline on/off count x y ... rotation 

5 Polygon on/off sides xcenter ycenter diameter rot 

Extended Gerber aperture macro primitives. 

Aperture macros are also programmable using replaceable parameters, which allow 
a macro to produce different results, depending on the aperture definition specified 
by the AD aperture definition command (explained in the preceding section). 
Replaceable parameters are indicated by a dollar sign ($) followed by a numeric 
value. The numeric value indicates the parameter's position within the AD aperture 
definition. A typical donut macro and corresponding definitions are shown below. 

%AMDONUT* 
1,1,$1,0.0,0.0* 
1,0,$2,0.0,0.0* 
% 

%ADD10DONUT,O.60XO.40% 
%ADD20DONUT,O.08XO.70% 

In the above example, D lOis defmed as a 60-mils donut with a 40-mils hole, and 
D20 is defined as a 80-mils donut with a 70-mils hole. Note that both DlO and D20 
refer to the same macro but have different sizes. 

GerbTool allows you to edit aperture macros using the Edit AM button within the 
Apertures/Edit dialog box. See Chapter 7: Command reference for more 
information. 
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Chapter 10 Extended Gerber 

Layer compositing 

With extended Gerber, a single Gerber file defines a composite image of arbitrary 
complexity. Each "layer" of data within the Gerber file is prefixed with an 
appropriate polarity command. Ordering of the layers is critical as the data is 
processed sequentially. For assistance, check the example files provided and notice 
how each layer either adds or removes from the initial image. 

GerbTool automatically creates separate layers for composite layers when reading an 
extended Gerber file and conversely creates a single file for all layers that form a 
composite when writing out data. 

Viewing composites 

Composite layers can be displayed with the V shortcut key. This nested command 
toggles composite viewing on or off. When enabled, GerbTool displays composite 
layers as they are plotted. When disabled, GerbTool displays composite layers as if 
all layers were dark (positive). You can also control composite viewing using the 
Edit dialog box. 

Converting from RS·274·0 to extended Gerber format 

In order to convert a set of standard Gerber 274D files into a single extended Gerber 
composite file, load the 274D files as you normally do and then perform the 
following steps using the Edit command (Layers menu): 

• Set the Layer Name field of each layer to a meaningful name. 

~ Tip Setting the Layer Name field to the original filename of the same layer will 
label the extended Gerber "layers" in a fashion that will be familiar to the user. 

• Decide on the filename you want to use for the new extended Gerber file and 
rename all of the Gerber filenames to this new name. It is important that each 
extended Gerber "layer" have the same filename. 

• Set the Layer Type for each of these layers to Composite. 

• Assign a polarity and a common number to the Key field for each of the 
extended Gerber "layers." For example, D I for "Dark composite number I" or 
CI for "Clear composite number I." A polarity of Dark means that the layer is 
to be displayed in the style a normal Gerber file is displayed. Clear tells 
GerbTool to display the layer using the current background color. This erases, 
or "clears," areas from an image that were previously drawn by a "dark" layer. 

, Set negative layers to clear. 

Fb Note The common number portion of the Key field allows GerbTool to load 
multiple extended Gerber composite files at the same time. Each set of layers within 
an extended .Gerber file should have a common number assign to the Key field. 
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• . Click on the Edit button within the File Format group box. Change the Dialect 
field to extended Gerber (274X). 

• Save the composite file using the Save command (File menu). All the layers will 
all be written into a single extended Gerber file with the name that you 
specified, along with an embedded aperture list. 

To load this new extended Gerber composite file into another design, enter its 
filename into the Filename field as you would with any other Gerber file, making 
sure the file format has been set to extended Gerber (274X). There is no need to load 
in an aperture list as it is included in the file. 
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Chapter 11 

Using custom apertures 

Using GerbTool, you can create custom apertures. A custom aperture is nothing 
more than a Gerber file, and can therefore be of virtually any size or shape. This 
chapter details the steps for creating a custom aperture. 

Create a custom aperture 
m Using the Format command (Files menu), set the Gerber format to Inch, 

absolute, 2.3 and no zero suppression. 

• Select the Load command (Files menu). 

• Enter the appropriate design filename. 

~ Tip Use one design file for all of your custom apertures. 

• In the Layers dialog box, enter a descriptive name in the Filename field, such as 
FIDUCIAL.CUS (the .CUS .extension is mandatory). 

• Enter the filename of the aperture list that you will be using for this custom 
aperture in the Aperture List field. 

• Choose the OK button. GerbTool will inform you that the specified Gerber file 
doesn't exist. Respond affirmatively to create the new layer. 

• At this point you can create your custom aperture using any of the apertures 
defined in the aperture list assigned to the new layer. 

Fb Note Before you save your custom aperture, ensure that the origin is where you 
want it. You can use the Origin command (Edit menu) to relocate the origin. 
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To use the new custom aperture, enter its filename (less extension) in the Shape field 
of an aperture list using the Edit command (Apertures menu). 

Caution The aperture list used while designing your custom aperture must be 
specified in the Custom Ap List field within the Defaults dialog box. Use the 
Defaults command (Options menu) to change this field if necessary. A aperture list 
used for custom apertu~es should not itself contain any custom apertures. 

~ Tip It is recommended that you set aside one aperture list dedicated to all Your 
custom apertures. 
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Chapter 12 

Working with text fonts 

Editing a font 

GerbTool uses a font file containing a list ofX-Y coordinate pairs that constitute the 
"strokes" required to display each character inserted by the Text command (Edit 
menu). You can have more than one font file but GerbTool will always read the 
STROKE.FNT file at startup. To use a different font file, rename STROKE.FNT to 
some other name, then rename your font file to STROKE.FNT. GerbTool allows 
you to edit existing fonts and create new fonts that are used for text insertion. This 
chapter details the steps for editing fonts. 

Before you edit a font you must convert it into individual Gerber files for each 
character. To do this, from the system prompt change to the GerbTool fonts 
directory and type the following command, then touch the ENTER key: 

f2g .. /stroke.fnt 

This will create an individual Gerber file for each character in the font file. You can 
now start GerbTool and load one of the provided design files UPCASE.GTD, 
LWCASE.GTD, NUMBERS.GTD, P{}NCI.GTD, or PUNC2.GTD, which cover 
uppercase, lowercase, numbers, and punctuation characters respectively. The Film 
Box is set to a 7 -mils square, which each character must remain within. You can 
draw any shape you want as long as you stay in or on the film box and you don't try 
to add flashes. 

Fb Note Itis important that the file format of the individual Gerber files for each 
character remain at Inch, absolute, 2.3, and no zero suppression. 

Once you have finished editing the characters, you can use the following command 
at the system prompt to create a new font file, then touch the ENTER key. 

g2f newfile.fnt 

In the above example a new font file would be created with a filename of 
NEWFILE.FNT. Note that this program does not purge the individual Gerber 
character files. You may do this manually if you want. Remember that GerbTool 
will not recognize your new font file unless it is named STROKE.FNT and is in the 
GerbTool program directory. 
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Creating a new font 

To create a completely new font you can follow the steps detailed in Editing a font 
above, but skip the font file to Gerber file conversion step. 

Fb Note It is usually easier (and faster) to modify an existing font than to create one 
from scratch. 
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Appendix A 

Command 10 values 

The tables in this appendix contain the command ID values associated with each 
GerbTool command. You can use these values to program your mouse and function 
keys. 

Command ID 

Compact (Apertures menu) AO 

Convert (Apertures menu) AV 

Edit (Apertures menu) AE 

Load (Apertures menu) AL 

Merge (Apertures menu) AM 

Report (Apertures menu) AR 

Save (Apertures menu) AS 

Unload (Apertures menu) AU 

Arc 3 Pt (Add item, Edit menu) EAA3 

Arc Ctr (Add item, Edit menu) EAAC 

Circle (Add item, Edit menu) EAC 

Draw (Add item, Edit menu) EAD 

Flash (Add item, Edit menu) EAF 

Polygon (Add item, Edit menu) EAP 

Rectangle (Add item, Edit menu) EAR 

Text (Add item, Edit menu) EAT 

Vertex (Add item, Edit menu) EAV 

Align (Edit menu) EA 

Clip (Edit menu) EK 

Command 10 values (page 1 of 5). 
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Command ID 

Copy (Edit menu) BC 

Expand (Dcode item, Edit menu) EDE 

Polarity (Dcode item, Edit menu) EDP 

Scale (Dcode item, Edit menu) EDS 

Transcode (Dcode item, Edit menu) EDT 

Erase (Edit menu) EE 

Item (Edit menu) ET 

Mirror (Edit menu) EI 

Move (Edit menu) EM 

Origin (Edit menu) EO 

Purge (Edit menu) EP 

Rotate (Edit menu) ER 

Add (Select item, Edit menu) ESA 

Invert (Select item, Edit menu) EPI 

New (Select item, Edit menu) ESN 

Off (Select item, Edit menu) ESO 

Remove (Select item, Edit menu) ESR 

Undo (Edit menu) EU 

Chgdir (File menu) FD 

Close (File menu) FC 

Exit (File menu) FQ 

BARCO DPF (Export item, File menu) FEB 

IPC-D-350 (Export item, File menu) FE350 

IPC-D-356 (Export item, File menu) FE356. 

Drill (Format item, File menu) FFD 

Gerber (Format item, File menu) FFG 

Load (Format item, File menu) FL 

BARCO DPF (Import item, File menu) FIB 

Command ID values (page 2 of 5). 
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Command ID 

Drill (Import item, File menu) FIN 

HPGL (Import item, File menu) FIH 

IPC-D-356 (Import item, File menu) FI356 

Design (Merge item, File menu) FMD 

Gerber (Merge item, File menu) FMG 

Auto (New item, File menu) FNA 

Manual (New item, File menu) FNM 

Open (File menu) FO 

HPGL (Plot item, File menu) FPH 

PostScript (Plot item, File menu) FPP 

Print (File menu) FP 

Save (File menu) FS 

Colors (Layers menu) LC 

Edit (Layers menu) LE 

Arcs 360 (Options menu) OA 

Bg Color (Options menu) OB 

Defaults (Options menu) OD 

Filmbox (Options menu) OF 

Grid (Options menu) OG 

KeyCmds (Options menu) OK 

Metric (Options menu) OM 

Ortho (Options menu) OR 

Overlay (Options menu) 00 

Save (Options menu) OV 

Show Errs (Options menu) OE 

Sketch (Options menu) OS 

Undo (Options menu) OU 

Copper (Query menu) QC 

Command ID values (page 3 of 5). 
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Command 

Extents (Query menu) 

Dcode (Highlight item, Query menu) 

Net (Highlight item, Query menu) 

Off (Highlight item, Query menu) 

Item (Query menu) 

Edge to Edge (Measure item, Query menu) 

Point to Point (Measure item, Query menu) 

Circles (Convert item, Tools menu) 

Pads (Convert item, Tools menu) 

DRC (Tools menu) 

Fix SS (Tools menu) 

Lyr Spread (Tools menu) 

Load (Macro item, Tools menu) 

Run (Macro item, Tools menu) 

Drawing (NC Drill item, Tools menu) 

Write· (NC Drill item, Tools menu) 

Generate (Netlist item, Tools menu) 

Write (Netlist item, Tools menu) 

Isolated (Pad Removal item, Tools menu) 

Stacked (Pad Removal item, Tools menu) 

Panelize (Tools menu) 

Snoman (Tools menu) 

Vent (Tools menu) 

All (View menu) 

Errors (View menu) 

Filmbox (View menu) 

Pan (View menu) 

Previous (View menu) 

Command ID values (page 4 of 5). 
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QE 

QHD 

QHN 

QHO 

QI 

QME 

QMP 

TCA 

TCP 

TD 

TF 

TL 

TML 

TMR 

TNDD 

TNDW 

TNLG 

TNLW 

TPI 

TPS 

TP 

TS 

TV 

VA 

VE 

VF 

VP 

VV 
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Command 10 

Recall (View menu) VC 

Redraw (View menu) VR 

Save (View menu) VS 

Window (View menu) VW 

ZoomIn (View menu) VI 

ZoomOut (View menu) va 

Command ID values (page 5 of 5). 

Command 10 

All (View menu) VA 

Film Box (View menu) VF 

Pan (View menu) VP 

Previous (View menu) VV 

Redraw (View menu) VR 

Window (View menu) VW 

Zoom In (View menu) VI 

Zoom Out (View menu) va 

Command ID values assignable to mouse buttons. 
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Appendix B 

Apertu re list file format 

This appendix describes the format of a GerbTool aperture list and provides an 
example of an aperture list. 

Aperture lists are stored as simple ASCII files. There are nine fields in each line of 
the file. Each line defines one D-code. The fields consist of the following: 

Field 

D-Code 

Shape 

Width 

Height 

Type 

Tool 

Tool Size 

Legend 

R90 

Possible values 

10 - 4095 

Round, Square, Rectangle, Oblong, Donut, Diamond, 
Octagon, Thermal, Therm45, Target, Complex, or a filename 
prefixed by a "%" 

0.0 - 9.9999 

0.0 - 9.9999 
When referring to Donuts or Thermals, this field represents 
the diameter of the inner hole. When referring to Targets, it 
refers to the diameter of the inner ring of the Target. 

SM (surface-mount) or TH (through-hole) 

0-999 
Specifies the Tool used to drill this D-Code. 

0.0 - 9.9999 
Specifies the size of the above Tool number. 

10 - 4095 
Specifies the D-Code to use in place of this D-Code when 
creating a Drill Drawing using the Drawing command from 
the Tools>Drill menu. 

10 - 4095 
Specifies the D-Code to substitute for this D-Code when 
rotating 90 or 270 degrees. This field exists only for 
compatibility with older versions ofGerbTool, as newer 
versions perform the D-Code substitutions automatically. 

Aperture list field definitions. 
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All fields are separated by white space. Lines that begin with a ''#'' are treated as 
comments. Although the author and data comments are not required, they are 
generally included as an aid for other users. The header of a GerbTool aperture list 
may contain a format line proceeded by a "%." This line contains either IMPERIAL 
or METRIC followed by a version number. If IMPERIAL is specified, all sizes are 
in inches. If METRIC is specified, they are in millimeters. Ifno format line is 
provided, IMPERIAL is assumed. The version number is for documentation 
purposes only. An excetpt from an aperture list showing the required format follows. 

# Format, Version 

%IMPERIAL, V3.0 

# 

# Author: GerbTool V1.0 (c) 1992 WISE Software 
Solutions, Inc. 

# Date: Wed Oct 7 13:28:46 1992 

# 

# Shape Width Height Type Tool Size Legend R90 

# 

D12 Round 0.0100 0.0100 TH 0 0.0 0 0 
D21 Square 0.0200 0.0200 TH 2 0.0 0 0 
D22 Rectangle 0.0220 0.0180 SM 3 0.0 85 0 
D23 Oblong 0.0220 0.0180 TH 3 0.0 0 0 
D24 Diamond 0.0240 0.0240 TH 4 0.0 0 0 
D25 Target 0.1800 0.1600 TH 0 0.0 0 0 
D26 %FIDUCIAL 0.0000 0.0000 TH 0 0.0 0 0 
D70 Octagon 0.0240 0.0240 TH 5 0.0 0 0 
D71 Thermal 0.0240 0.0200 TH 0 0.0 0 0 

Sample aperture list file. 

In the above example, D26 is specified as a Custom aperture with a filename of 
FIDUCIAL.CUS. The "%" is required, to notify GerbTool that what follows is a 

. custom aperture filename. 

298 OrCAD Layout for Windows GerbTool User's Guide 



Appendix C 

Snoman concepts 

Snoman creates a maximum material condition at the point where a trace segment 
enters a pad, thereby eliminating the possibility of pad/trace separation (breakout). 
This is accomplished by examining a Gerber file (layer) and outputting pad flashes 
at the correct locations, and of the correct size, to provide the most material where a 
trace enters a pad. Automatic adjustments are made to the size and location of the 
generated Snoman pads to eliminate design rule spacing violations. 

The following illustration shows the original pad and trace, as well as the resultant 
Snomanpad. 

Host pad Snomanpad 

Host offset Trace 

Snoman concept. 

The distance maintained between the host pad center and the edge of the generated 
Snoman pad (see Host offset in illustration above) is adjustable. Negative values 
allow the Snoman pads to closely hug the host pads. 
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A 
absolute mode When all X-Y coordinates 
are referenced to a common origin (0,0). 

active layer The layer that all items added to 
the database will go to. 

aperture list A list of Gerber D-Code 
definitions. 

B-C 
block size The size of a coordinate value in 
characters. Also known as m.n format. 

breakout Pad and trace separation during 
fabrication. 

D-H 
design file A file containing information 
about the layer structure of a single PCB design. 
This file also stores various information about 
the GerbTool operating environment. 

ORe Acronym for Design Rules Check. 

Glossary 

J-M 
incremental mode When each X-V 
coordinate is a displacement from the previous 
coordinate. 

isolated pads Pads that do not have a trace 
connected to them. 

N-O 
NC drill Refers to files produced to drive 
Numerically Controlled drilling machines. 

netlist A file containing groups of pad X-V 
locations that are connected by traces. 

p-u 
pad removal The act of removing isolated or 
stacked pads. 

pan Moving the location of the viewing 
window without changing its size. 

panelize Placing multiple copies of a PCB on 
one piece of film. The multiple copies are then 
manufactured on a single panel, thereby 
reducing manufacturing costs. 

point A X-Y location within the drawing area. 
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·'···ll· ... ' .... ' .... , ': .... :, :.~. '. :. '; .~ 

virtual memory A combination of hardware 
and software that allows an application to 
address all memory that the CPU is capable of 
addressing, even when there is less actual 
memory. The virtual memory manager swaps 
data back and forth to the disk and remaps 
memory addresses to provide applications with 
virtually unlimited memory. Available disk 
space becomes the limiting factor. 

w-z· 
wildcard specification A method of 
specifying more than one filename at a time. Use 
the asterisk (*) character to match any character 
or group of characters. Use a question mark (?) 
to match a single character. For example: *.GTD 
represents all files that end with the .GTD 
extension. 
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A 
active layer, 14 
add 

arc, 56 
arc 3 pt, 56 
circle, 55 
draw, 55 
flash, 55 
polygon, 56 
rectangle, 55 
text, 58 
vertex, 55 

aligning layers, 21, 51 
annular ring, 89 
aperture conversion rules 

#,278 
CUSTOM, 276 
DCODE,278 
DEBUG, 277 
DEFAULT_UNITS, 276 
EXTENSION; 277 
FORMAT_shape, 279 
FORMAT_SPECIAL, 280 
FORMAT_UNITS, 279 
HEADER, 275 
NAME, 274 
SKIP, 275 
VERSION,274 
XTENSION, 278 

aperture list 
compacting, 68 
converting, 6, 68 
create, 68 
editing, 64 
embedded, 283 

files, 15 
format, 297 
load,68 
merging, 68 
saving, 68 
unloading, 68 
use report, 67 

apertures 
custom, 65 
definition, 66 
macro, 65, 66, 284 
maximum size, 75 

arcs 
chord angle, 75, 242 
conversion, 100 
interpolated, 13, 73 

B 
background color, 77 
BARCODPF 

exporting, 36 
importing, 34 

birdseye view, 11 
breakout, 299 

c 
calculating 

copper, 72 
data extents, 72 

chord angle, 75 
color list file, 3 
command ID, 291 
compacting 

aperture list, 68 

I n d e X 

DrCAD Layout for Windows Gerb Tool User's Guide 303 



Index 

composite layers, 23 
274X,61 

composites, 274X, 285 
composites, viewing 274X, 53, 285 
configuration, 3 
configure 

aperture converters, 78 
function keys, 77 
macro files, 80 
mouse, 77 
paths, 79 
user menu, 81 

conversion 
aperture lists, 15 
arcs, 100 
drawn pads, 99 
RS274D to 274X, 285 

converting aperture list, 68 
coordinate display, 14 
copper calculation, 72 
copying, 47 
creating a soldermask layer, 26 
creating NC Drill files, 22 
crosshair 

size, 76 
crosshair cursor, 14 

o 
data extents calculation, 72 
D-code 

expand, 50 
highlight, 72 
polarity, 51 
scale, 50 
transcode, 26, 50 

deleting, 48 
deleting with clipping, 48 
design 

automatic, 8, 29 
closing, 30 
creating, 9, 29 
merging, 24, 33 
opening,9,30 
save, 30 
save all, 30 
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save as, 30 
destination layer 

copying, 47 
moving, 48 

drawing 
interrupting, 18, 19 

drawing area, 11, 14 
drawn pads, 25 

conversion, 99 
DRC, 88 

annular ring, 89 
keepouts, 90 
missing drill, 89 
stubs, 89 
view errors, 90 
well behaved, 89 

E 
edit item, 47 
editing 

aperture list, 64 
editing layers, 59 
ending a command, 18 
exiting GerbTool, 10, 42 
exporting 

BARCO DPF, 36 
HPGL,37 
IPC-D-350, 36 
IPC-D-356, 36 
PostScript, 39 

F 
file format 

critical, 35 
detection, 62 
global,31 
local, 31, 62 
metric, 32 

film box, 15 
change, 76 

fonts 
creating, 290 
editing, 289 

function key assignments, 16 



G 
Gerber dialect 

274X,31 
EIE,31 
FlRE9xxx, 31 

Gerber files, 15 
grid 

change size, 76 
display, 13, 53 
snap, 13 

group 
selecting, 45 

GTMAPDIR, 79 

H 
highlight 

clear, 53 
colors, 76 
D-codes,72 
nets, 70 
selections, 54 
toggle, 53 
userdata, 71 

importing 
BARCO DPF, 34 
IPC-D-356 netlist, 35 
NC Drill file, 35 

interactive plot positioning, 38 
IPC-D-350 

exporting, 36 
IPC-D-356 

exporting, 36 
IPC-D-356 netlist 

importing, 35 
isolated pad removal, 97 
item 

editing, 47 
item information 

displaying, 69 

J-K 
join, 49 
joining lines, 49 

L 
layers 

active, 14 
aligning, 51 
alignment, 21 
color and visibility, 63 
color, floating, 11 
composite, 23 
create, 63 
editing, 59 
maximum, 75 
path, 60 
rearranging, 61 
ref mode, 75 
save, 30 
save all, 30 
save as, 30 
spread, 101 
visibility, 61 

lines 
chamfer, 49 
fillet, 49 
joining, 49 

loading macros, 106 

M 
macro 

coordinate lists, 105 
edit, 82 
function keys, 77 
language reference, 107 
loading, 82, 106 
running, 82, 106 
system variables, 104 

macros 
ABORTCHECKRATE,258 
ABS, 198 
ACTIVELA YER, 165 
ADD3PTARC,108 
ADDARC, 109 

Index 
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Index 

ADDCIRCLE,110 
ADDDRA W, 111 
ADDFILL, 112 
ADDFLASH,113 
ADDPOUR,114 
ADDTEXT,115 
ADDVERTEX,116 
ALIGNLA YERS, 138 
APREPORT, 117 
ARRAY, 199 
ASIN,200 
ATAN,201 
BKCOLOR, 166 
CALC, 202 
CALLMACRO, 120 
CEIL,203 
CLIP, 139 
COPY, 141 
COPYITEM,125 
CREATELA YER, 259 
CSIN,204 
CURRENTDCODE, 167 
DCEXPAND,143 
DCODESCALE, 144 
DEBUG,121 
DELETEITEM, 126 
DRAWNPADS, 231 
DRC, 233 
DRILL,235 
ERASE,146 
EXTENSIONS, 168 
FILECLOSE, 191 
FILEOPEN,192 
FILEREAD,193 
FILESP A TH, 169 
FILE WRITE, 194 
FILMBOX, 170 
FIXSS, 237 
FLAGS, 171 
FLOOR, 205 
FORMAT,172 
GETAPINFO,118 
GETEXTENTS, 127 
GETFILMBOX, 128 
GETFIRSTITEM, 129 
GETLA YER, 131 
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GETNEXTITEM, 133 
GETPOINT, 249 
GETSTRING,250 
GETUSERDATA,134 
GETV ALUE, 252 
GETVIEWEXTENTS, 135 
GETWINDOW, 251 
GETYESNO, 253 
GRID SIZE, 174 
GRIDSNAP, 175 
GRIDVISIBLE, 176 
HILICOLORS, 177 
HILIDCODE,216 
HILIITEM, 217 
IF,122 
LAYERN,178 
MAPPATH, 180 
MEASUREE2E,218 
MERGEDRILL,195 
MERGE GERBER, 196 
MERGEHPGL,197 
MESSAGEBOX, 254 
MIRROR,148 
MOVE,150 
MOVEITEM, 136 
NETID,181 
NETLIST, 238 
OFFSETS, 182 
ORIGIN,152 
OVERLAYMODE,183 
PADREMOV AL, 239 
PANELIZE, 240 
PAUSE,257 
PLOTHPGL, 212 
PLOTPS,214 
POUR,153 
PREVIOUS VIEW, 184 
PURGE,155 
PUTAPINFO, 119 
PUTUSERDATA, 13 7 
REDRAW,262 
REPEAT,123 
ROTATE,156 
ROUND,206 
SCALE,185 
SEGMENTARCS, 242 



SELECTCRITERIA, 158 
SELECTGROUP, 159 
SET,207 
SETGLOBAL, 208 
SETPROMPT, 255 
SHOWERRORS, 186 
SHOWPROMPT,256 
SIN,209 
SKETCHMODE, 187 
SNOMAN,243 
SPLITPATH, 260 
SPREAD,247 
SQRT,210 
STOP, 124 
STRARRAY, 219 
STRCAT,220 
STRCMP, 221 
STRCPY, 222 
STRLEN,223 
STRLOC, 224 
STRREAD, 225 
STRSET,226 
STRSETGLOBAL,227 
STRSUB,228 
STRTOK,229 
STRWRITE, 230 
SYSCMD,261 
TAN,211 
TEARDROPS, 245 
TEXT,161 
TRANSCODE, 163 
UNDO, 188 
VENT,248 
VIEWALL,263 
VIEWCOMPOSITES, 189 
VIEWFILMBOX, 264 
VIEWMETRIC, 190 
VIEWPAN, 265 
VIEWPREVIOUS, 266 
VIEWRECALL, 267 
VIEWSA VE, 268 
VIEWWINDOW, 269 
ZOOMIN,270 
ZOOMOUT, 271 

measuring 
edge-to-edge, 71 

point-to-point, 71 
merging 

aperture list, 68 
design file, 24, 33 
Gerber file, 33 
HPGL file, 34 

metric mode, 13, 73 
mirroring, 49 
mouse button assignments, 16 
moving, 48 

N 
NC Drill, 15 

creating, 22, 98 
drawing, 97 
importing, 35 
tools, 65 

netlist 
generate, 94 
highlight, 70 
saving, 32, 95 
well behaved, 94 

o 
offsets 

applying, 50 
operating environment, 15 
origin, 51 
ortho 

line angle, 75 
orthogonal mode, 13, 73 
overlay mode, 12 
overview, 5 

p 
pad removal 

isolated, 97 
stacked,97 

page setup, 41 
panelize, 23, 83 

virtual, 87, 98 
panning, 52 
plotting 

batch mode, 38, 40, 41 

Index 
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Index 

borders, 37, 39, 212, 214 
composite layers, 39 

polygon 
filling, 56 
pouring, 56 

PostScript plotting, 39 
print preview, 42 
printer setup, 42 
printing, 42 

borders, 41 
programming 

function keys, 20 
mouse buttons, 20 

purging, 51 

Q 
query 

nets, 70 
userdata, 71 

querying 
database information, 69 

R 
redraw 

minimize, 77 
rotating, 49 
rule violation 

displaying, 12, 54 
running macros, 106 

s 
save, 30 
save all, 30 
save as, 30 
scale 

database, 50 
D-codes,50 

selecting groups, 45 
selection criteria, 43 
settings 

current, 12 
shortcut keys, 17, 19 
silkscreen 

automatic cleanup, 25 

auto fixup, 96 
sketch mode, 12 
Snoman, 27, 91 
soldermask layer 

creating, 26 
split scre~n, 11 
starting GerbTool, 5 
status bar, 15 
step and repeat, 98 
surface-mount pads, 65 

T 
teardrops, 92 
text, 58 
thieving, 101 
through~hole pads, 65 
tool tips, 11 
toolbar,11 
transcode,26 

u 
undo, 19,44 

toggle, 75 
unused pad removal, 97 
userdata 

editing, 47 
highlight, 71 

v 
vent 

automatic. 86 
manual, 101 

view 
all, 52 
birdseye, 14 
composites, 12, 53 
errors, 12, 90 
film box, 52 
grid, 53 
new window, 52 
overlay mode, 53 
panning, 52 
previous, 54 
recall, 54 
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redrawing, 53 
saving, 54 
sketch mode, 53 
split screen, 14, 54 
toolbars, 54 
virtual panel, 53 
zoom in, 52 
zoom out, 52 

W-y 
well behaved 

DRC, 89 
netlist,94 

window, 11 
wizard 

new design, 29,74 

z 
zero suppression, 32 
zooming in, 52 
zooming out, 52 

Index 
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